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Chapter 827

Joint Tests of
Mediation in Linear
Regression with
Continuous Variables
Introduction
This procedure computes power and sample size for evaluating mediation analysis of a continuous dependent
variable Y and continuous independent variables X and M. It is assumed that joint testing will be made of both
links (regression models) of an indirect pathway assuming that the tests are asymptotically independent. The
sample size calculations are based on the work of Vittinghoff and Neilands (2015).

Mediation Model
An in-depth discussion of mediation can be found in Hayes (2018). A popular method for testing for mediation is
that of Baron and Kenny (1986). In this method, three regression models are fit where
2)
𝑀𝑀~N(𝜇𝜇𝑀𝑀 , 𝜎𝜎𝑀𝑀
and 𝑋𝑋~N(𝜇𝜇𝑥𝑥 , 𝜎𝜎𝑋𝑋2 ).
(1) 𝑀𝑀 = 𝜃𝜃0 + 𝜃𝜃𝑋𝑋 𝑋𝑋 + 𝑒𝑒𝑀𝑀 , 𝑒𝑒𝑀𝑀 ~N�0, 𝜎𝜎𝑒𝑒2𝑀𝑀 �

(2) 𝑌𝑌 = 𝛽𝛽0 + 𝛽𝛽𝑋𝑋 𝑋𝑋 + 𝛽𝛽𝑀𝑀 𝑀𝑀 + 𝑒𝑒𝑌𝑌 , 𝑒𝑒𝑌𝑌 ~N�0, 𝜎𝜎𝑒𝑒2𝑌𝑌 �
(3) 𝑌𝑌 = 𝛽𝛽0∗ + 𝛽𝛽𝑋𝑋∗ 𝑋𝑋 + 𝑒𝑒𝑌𝑌 ∗

Vittinghoff, Sen, and McCulloch (2009) derived sample size formulas based on testing the significance of 𝛽𝛽𝑀𝑀 in
model 2. Vittinghoff and Neilands (2015) extended these results to give results for testing 𝜃𝜃𝑋𝑋 = 0 in model 1 and
𝛽𝛽𝑀𝑀 = 0 in model 2 simultaneously. They added adjustment factors for confounders in model 1 and model 2. They
also added an adjustment for cluster randomized designs, if they are used.
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Calculating the Power
Power calculations are based on standard normal distribution. They proceed as follows:
1. Determine the critical value 𝑧𝑧1−𝛼𝛼 from the standard normal distribution where α is the probability of a
type-I error.
2)
𝑁𝑁𝑁𝑁2 𝜃𝜃2 (1−𝑅𝑅𝑋𝑋

2. Calculate: 𝑧𝑧𝛽𝛽1 = � 𝛿𝛿𝜎𝜎𝑋𝑋2 𝑋𝑋 2
(1−𝜌𝜌
𝑀𝑀

𝑋𝑋𝑋𝑋 )

− 𝑧𝑧1−𝛼𝛼 .

2 𝛽𝛽 2 (1−𝜌𝜌2 )(1−𝑅𝑅 2 )
𝑁𝑁𝑁𝑁𝑀𝑀
𝑀𝑀
𝑋𝑋𝑋𝑋
𝑀𝑀

2. Calculate: 𝑧𝑧𝛽𝛽2 = �

𝛿𝛿𝜎𝜎𝑒𝑒2𝑌𝑌

3. Calculate: Power = Φ(𝑧𝑧𝛽𝛽1 )Φ(𝑧𝑧𝛽𝛽2 ).

− 𝑧𝑧1−𝛼𝛼 .

Notes

𝛼𝛼
2

1. Use instead of 𝛼𝛼 for two-sided test.

2. 𝜌𝜌𝑋𝑋𝑋𝑋 = 𝜃𝜃𝑋𝑋 𝜎𝜎𝑋𝑋 /𝜎𝜎𝑀𝑀 must be between -1 and 1.

3. 𝑅𝑅𝑋𝑋2 is squared multiple correlation of X on any confounding variables.

2
4. 𝑅𝑅𝑀𝑀
is squared multiple correlation of M on any confounding variables.

5. 𝛿𝛿 is the design effect which is defined as the ratio of the actual variance of Y with clustering to its
variance under simple random sampling.

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. Under most situations, you will
select either Power or N (Sample Size).
Select Sample Size when you want to calculate the sample size needed to achieve a given power and alpha level.
Select Power when you want to calculate the power of an experiment.

Test Direction
Alternative Hypothesis
Specify whether the hypothesis test is one-sided or two-sided. When a two-sided test is selected, the value of
alpha is automatically divided by two. A two-sided test requires alpha to be less than 0.50.
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Power and Alpha
Power
In this case of the joint testing of two hypotheses, Power is the product of the powers of those two individual
hypotheses. This assumes that the two tests are approximately independent.
The two null hypotheses are
1. H01: θx = 0 in model 1.
2. H02: βᴍ = 0 in model 2.
Range
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error (alpha) which is used for both tests.
A type-I error occurs when you reject the joint null hypothesis when in fact it is true.
Values of alpha must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means
that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that
represents the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size
N (Sample Size)
This option specifies the value(s) for N, the sample size. Note that 3 < N.

Effect Size
θX (Reg Coef of X in Model 1)
Enter one or more values for θX, which is the coefficient of X in model 1:
Model 1: M = θ0 + θx(X) + eᴍ

where X is the primary predictor variable and M is the mediator variable.
Range
θX can be any value other than zero. It is in the same scale as σX.
βᴍ (Reg Coef of M in Model 2)
Enter one or more values for βᴍ, which is the coefficient of M in the regression model
Y = β0 + βx(X) + βᴍ(M) + eʏ
where X is the primary predictor variable and M is the mediator variable.
Range
βᴍ can be any value other than zero. It is in the same scale as σᴍ.
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σX (Standard Deviation of X)
Enter one or more values for the standard deviation of X, the primary predictor variable.
Range
0 < σ X.
σM (Standard Deviation of M)
Enter one or more values for the standard deviation of M, the mediator variable.
Range
0 < σM.
σe (Standard Deviation of eY)
Enter one or more values for the standard deviation of eY from the model
Y = β0 + βx(X) + βᴍ(M) + eY
Range
0 < σe.
DE (Design Effect)
DE is the design effect. It is used to adjust the sample size when a cluster randomized trial is being used. It is the
ratio of actual variance of the outcome, Y, with clustering to its variance assuming simple random sampling.
Range
Any value greater than zero can be used. If you are NOT using a cluster randomized trial, then enter 1.0.
R2X (R² of Confounders in Model 1)
Enter one or more values of R²x. This value is used to form a correction factor when confounders are used in
Model 1. This value is the value of R² that is achieved when X is regressed on the confounders.
Range
0 ≤ R²x < 1.
If there are no confounders, enter '0'.
R2M (R² of Confounders in Model 2)
Enter one or more values of R²M. This value is used to form a correction factor when confounders are used in
Model 2. This value is the value of R² that is achieved when M is regressed on the confounders.
Range
0 ≤ R²M < 1.
If there are no confounders, enter '0'.
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Example 1 – Finding Sample Size
Researchers are studying the relationship between a dependent variable (Y) and an independent variable (X).
They want to understand the impact of a third variable (M) on the relationship between X and Y, so they decide to
carry out a mediation analysis. They decide to determine the sample size based on the joint significance tests.
Using prior analyses, they decide to use θx = 0.5, 0.7; βᴍ = 0.5, 0.6, 0.7, σX = σᴍ = σe = DE = 1; R²x = 0.1; and
R²M = 0.2. They set the power at 0.9 and the two-sided significance level at 0.05.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Joint Tests of Mediation in Linear Regression with Continuous Variables procedure. You
may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and
choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ N (Sample Size)
Alternative Hypothesis ............................ Two-Sided
Power ...................................................... 0.90
Alpha ....................................................... 0.05
θx (Reg Coef of X in Model 1) ................ 0.5 0.7
βᴍ (Reg Coef of M in Model 2) ............... 0.5 0.6 0.7
σx (Standard Deviation of X) .................. 1
σᴍ (Standard Deviation of M) ................. 1
σe (Standard Deviation of eʏ)................. 1
DE (Design Effect) .................................. 1
R²x (R² of Confounders in Model 1) ........ 0.1
R²ᴍ (R² of Confounders in Model 2) ....... 0.2

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results ────────────────────────────────────────────────────────────
Two-sided alternative hypothesis

Joint
Power
0.9002
0.9030
0.9044
0.9027
0.9018
0.9024

Individual Sample
Powers
Size
Pw1/Pw2
N
0.996/0.904
71
0.979/0.923
53
0.953/0.949
44
1.000/0.903
104
1.000/0.902
72
1.000/0.902
53

Reg
Coef
of X
θx
0.50
0.50
0.50
0.70
0.70
0.70

Reg Corr
Coef of X
of M and M
βᴍ ρxᴍ
0.50 0.50
0.60 0.50
0.70 0.50
0.50 0.70
0.60 0.70
0.70 0.70

Std
Dev
of X
σx
1.00
1.00
1.00
1.00
1.00
1.00

Std
Dev
of M
σᴍ
1.00
1.00
1.00
1.00
1.00
1.00

Std
R²
R²
Dev Conf Conf
of eʏ Mdl 1 Mdl 2
σe
R²x
R²ᴍ
1.00 0.10 0.20
1.00 0.10 0.20
1.00 0.10 0.20
1.00 0.10 0.20
1.00 0.10 0.20
1.00 0.10 0.20

Des
Eff
DE
1.00
1.00
1.00
1.00
1.00
1.00

Alpha
0.050
0.050
0.050
0.050
0.050
0.050
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Report Definitions
Hypotheses: H0: βᴍ = 0 versus H1: βᴍ ≠ 0. (Two-Sided).
X is the primary predictor. It is an independent variable.
M is the mediator. It is the dependent variable in model 1 and an independent variable in model 2.
Model 1: M = θ0 + θx(X) + eᴍ.
Model 2: is Y = β0 + βx(X) + βᴍ(M) + eʏ. The eʏ's are normally distributed.
Power is the probability of rejecting a false pair of null hypotheses that both θx and βᴍ are zero.
Pw1 is the probability of rejecting a false null hypotheses that θx is zero in model 1.
Pw2 is the probability of rejecting a false null hypotheses that βx is zero in model 2.
N is the number of observations on which the multiple regressions are computed.
θx is the regression coefficient of X in model 2.
βᴍ is the regression coefficient of the mediator in model 2.
ρxᴍ is the correlation between X and M.
σx is the standard deviation of X.
σᴍ is the standard deviation of M.
σe is the standard deviation of the eʏ in the model.
R²x is R² achieved when X is regressed on any confounder variables in model 1.
R²ᴍ is R² achieved when M is regressed on any confounder variables in model 2.
DE is the design effect (the ratio of actual variance of the outcome, Y, with clustering to its variance
assuming simple random sampling).
Alpha is the probability of rejecting a true null hypothesis. It should be small.
Summary Statements ─────────────────────────────────────────────────────────
A sample size of 71 achieves 90% joint power to detect θx = 0 in model 1 and βᴍ = 0 in model 2
(assuming the independence of models 1 and 2) when the two-sided significance level (alpha) is
0.050. The individual power associated with model 1 is 100. The individual power associated
with model 2 is 90. The regression coefficient, θx, in model 1 is 0.50. The regression
coefficient, BM, in model 2 is 0.50. The standard deviation of the primary predictor variable,
X, is 1.00. The standard deviation of the mediator variable, M, is 1.00. The standard deviation
of the residuals in model 2 is 1.00. The correlation between X (the primary predictor) and M
(mediator) is 0.50. The R² achieved when X is regressed on any confounder variables in model 1
is 0.10. The R² achieved when M is regressed on any confounder variables in model 2 is 0.20.
The design effect (the ratio of actual variance of the outcome, Y, with clustering to its
variance assuming simple random sampling) is 1.00.

This report shows the necessary sample sizes. The definitions of each of the columns is given in the Report
Definitions section.

Plots Section

This plot shows the relationship between sample size and effect size.
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Example 2 – Validation using Vittinghoff (2015)
Vittinghoff et al. (2015) present an example which θx = 0.25; βᴍ = 0.2, σX = σᴍ = σe = DE = 1; R²x = 0.0; and
R²M = 0.09. They set the power at 0.8 and the two-sided significance level at 0.05. The computed N is 240.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Joint Tests of Mediation in Linear Regression with Continuous Variables procedure. You
may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and
choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ N (Sample Size)
Alternative Hypothesis ............................ Two-Sided
Power ...................................................... 0.80
Alpha ....................................................... 0.05
θx (Reg Coef of X in Model 1) ................ 0.25
βᴍ (Reg Coef of M in Model 2) ............... 0.2
σx (Standard Deviation of X) .................. 1
σᴍ (Standard Deviation of M) ................. 1
σe (Standard Deviation of eʏ)................. 1
DE (Design Effect) .................................. 1
R²x (R² of Confounders in Model 1) ........ 0.0
R²ᴍ (R² of Confounders in Model 2) ....... 0.09

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results ────────────────────────────────────────────────────────────
Two-sided alternative hypothesis

Joint
Power
0.8014

Individual Sample
Powers
Size
Pw1/Pw2
N
0.980/0.818
241

Reg
Coef
of X
θx
0.25

Reg Corr
Coef of X
of M and M
βᴍ ρxᴍ
0.20 0.25

Std
Dev
of X
σx
1.00

Std
Dev
of M
σᴍ
1.00

Std
R²
R²
Dev Conf Conf
of eʏ Mdl 1 Mdl 2
σe
R²x
R²ᴍ
1.00 0.00 0.09

Des
Eff
DE Alpha
1.00 0.050

PASS obtained 241 which is one higher than the 240 they calculated. It turns out that 240 has achieves a power
that is slightly less than the 0.8 that was desired. Thus, 241 is the correct answer.
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